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Setting up a Call Center

There are multiple levels to your managedIP Call Center. The levels are set up in the following format: 
Enterprise > Group > Call Center > Users. 

The Enterprise level is the highest level within managedIP Call Center and has links and configurations 
for all locations/call centers for your business. Enterprises with multiple sites (or groups) can have a call 
center created in any site. However, if the call center supports multiple sites, it is suggested that it be part 
of the main site for better management. Some specific features are configured at the Enterprise level 
and become the default for the rest of the users.  

The Group level contains the users assigned to a location or call center. A group can, but is not required 
to, contain a call center.  

The Call Center level contains all the configurations and users assigned to a call center queue.

The User level contains the individual configurations for a specific user or phone number. Users within Call 
Center come in two forms: Agents and Supervisors. Agents are users who have been assigned to call 
centers. Supervisors are users who are responsible for call center queues and agents. They can act as 
agents as well. 

Enterprise Settings

To begin configuring your call center queue, go to the Profile page. Here, you can set up the basic 
options of your queue as well as assign users and settings. To save any changes or updates that you 
make on this page, click the Save button on either the top or bottom of the page.

AGENT DEFAULT SETTINGS

Guard Timer–The Guard Timer is an Agent Default Setting that, when enabled, delays the delivery of a 
new Automatic Call Distribution (ACD) call until the timer expires. It is designed to prevent a new ACD call 
from being presented to the agent immediately after they end the previous call. 

When configured at the Enterprise level, agents will receive default settings for the Guard Timer  
and Unavailable Settings.
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GUARD TIMER SETTING: 

1. �Select Default or Enterprise. If selecting Enterprise, all call center queues will share the enabled 
Guard Timer setting configured here.  

2. �To change the number of seconds for the Guard Timer, click the drop-down menu and select a 
number between 1-25 seconds.

3. Click Save.

ROUTING POLICIES

How calls are routed to agents can be configured in the Routing Policies section of the screen. Calls 
received by the call center are placed in the queue based on the call’s priority and the wait time. The 
wait time of a call corresponds to the time elapsed from the moment that the call enters a queue to  
the moment the call exits the queue. Select one of two options:

• �Longest Wait Time - When this setting is selected, the longest waiting call is selected and delivered to 
the agent (across all queues the agent is staffing).

• �Priority Order - If this setting is selected, then a list of precedence is configured among the queues of 
the group/enterprise. The call from the highest precedence queue the agent is staffing is selected and 
delivered to the agent. 

Click Save to keep your changes.

For examples of how these features are used, please see the Use Cases section.  

For queue specific routing policies, see the Call Center Settings section.



4

managedIP Hosted
Call Center Administrator Guide

17
94

77
/4

-1
8/

10
54

1

AGENT UNAVAILABLE CODES 

Agent unavailable codes are configurable attributes that are applied when an agent becomes 
unavailable. Agents may select a reason for changing their agent (ACD) states to Unavailable (for 
example, on lunch, in the bathroom, taking a coffee break or a personal break). Call center managers 
can use this data to better understand the performance of their agents.

Each company may define many agent unavailable codes to track the performance of agents. These 
codes are usable by all the queues in the company.

Unavailable codes are also known as Reason Codes or Walk-away codes. The agent unavailable 
code creates additional attributes that are applied when a call center agent goes to the Unavailable 
state. There are many reasons why agents change their states to Unavailable. With the new attributes, 
call center supervisors have more information to monitor the performance of their agents. The agent 
unavailable codes contain two elements: an identification value and a description.
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CALL DISPOSITION CODES

Disposition codes provide agents with the possibility to enter disposition codes for a call center call. 
The purpose of these codes is to associate a given call center call with a marketing promotion or other 
elements.

The disposition codes contain two elements: an identification value and a description.

Disposition codes can be created at the enterprise for the enterprise model (under Call Center) and at 
the call center level (under Profile > Call Disposition Codes). 

Disposition codes may be entered by the call center agent while the call center call is in progress 
or once the call has been finished and the call center agent is in Wrap-up state. When the agent 
enters the disposition code while the call is in progress, the agent selects the call identification as well 
as the disposition code. The agent may be involved in several ongoing calls and therefore the call 
identification is required to ensure that the entered disposition code is associated with the appropriate 
call center call. When the agent enters a disposition code while in Wrap-up state, the agent provides 
only the disposition code. 

Here you can add, edit, or delete your call disposition codes. The disposition codes contain two 
elements: a code and a description.
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To add, simply click on the Add button. You will then see the following screen: 

1. Check the Active box to make the code active

2. Enter the numerical code value 

3. Enter a description for tracking purposes

Here is an example:

You may also edit and delete your call disposition codes. Click Save to apply any changes.
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Call Center Settings

To set up a call center queue at the Group level:

1. Select Group Services – Call Center.

2. Select the call center/queue you wish to modify from the drop-down list.

3. Begin configuring your call center queue in the Profile page. 

PROFILE SETTINGS

In this section of the Profile screen you can set up the basic call center queue options as well as assign 
users and settings. To save any changes or updates that you make on this page, click the Save button 
on either the top or bottom of the page.

• �Change Password - In this section of the Profile page, you can configure the web access and voice 
portal passwords associated with the call center queue. Each call center supervisor will be required 
to enter the web portal password for each queue they are supervising within the supervisor client 
configuration. By doing so, the supervisor has access to real time queue statistics. The Voice Portal 
Passcode is used to access the call center Voice Messaging service (optional).
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To change passcode settings, click the Change Password button. The following screen will display:

• �Name - This is the name associated with the call center queue.

• �Calling Line ID (First, Last Name) - This is the information that will be presented to your agents when 
an inbound call is received, enabling them to identify the specific queue the caller is in. 

• �Department - If you use Departments and/or Department Administrators, select the department you 
want to associate this call center with.

• �Time Zone - This is the Time Zone used by the call center queue. 

• �Group Policy - This is how inbound calls will be routed when placed within the queue. There are 
multiple options:

- �Circular: Incoming calls route to agents in the order they appear on the Assigned Users list.  
When the search reaches the end of the list, it loops back to the top and continues until it  
has tried all users.

- �Regular: Incoming calls route to agents in the order they appear on the list, always starting  
from the first/top agent.

- �Simultaneous: Incoming calls alert all agents at the same time. The first agent to answer  
handles the call.

- �Uniform: Incoming calls route to all agents in order, starting with the agent who has  
been idle the longest.

- �Weighted Call Distribution: Incoming calls are assigned to idle agents based on  
percentages you assign on this page.
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• �Statistics - Call Center Statistics allows you to view the statistics of your call center queue and  
configure statistics reporting. 

• �Daily Report - Check the box to enable statistical reporting for this queue. Uncheck the box if  
no daily statistical report is required.

• �Reporting Period - From the drop-down, select the period and interval you would like to collect 
statistics about.

• �Email Addresses - Enter up to two email addresses to receive the daily statistics report.

Click Save to save any changes.
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Call Center Settings

Within the Call Center Settings area, you will see your 
available number of queue slots for taking inbound calls 
and be able to configure options for those calls.

• �Queue Slots - Set a limit for the number of calls the 
system keeps on hold in queue.

NOTE: This setting represents the number of queue slots you have purchased and may  
not be modified.

• �Play ringing when offering call - Check or uncheck this option if you would like to ring the agent’s 
phone when offering a call.

• �Allow callers to dial X to escape out of queue - By selecting this option, callers will have the ability 
to press a number to escape the queue. The system default is “0”, but it can be changed by entering 
a different number in the box.  

NOTE: Call Treatment will follow Call Forward Busy if enabled in the queue. If not, it will  
follow Overflow.

• �Reset caller statistics upon entry to queue - Check or uncheck to reset caller statistics when a caller 
enters a queue. This can be helpful when trying to gain accurate reporting about a specific call center 
when you have multiple call centers that interface with each other.

Agent Settings

In this section, you can make changes to all agent parameters.  

• �Allow agents to join Call Centers – This setting allows agents to join or remove themselves from a 
call center queue via their web portal or their call center client. If this option is not selected, only an 
Administrator or Supervisor may “join” an agent to a call center. 
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• �Allow Call Waiting on agents - Check or uncheck the Allow Call Waiting on Agents box if you want 
queued calls to wait on busy agent stations when no other agents are available to take the call.

NOTE:  
• For this feature to work at the Group level, the feature must be active on a User/Agent level. 
• �Call center queue calls will not wait if the Group option is not active, even though the User/Agent 

may have Call Waiting active for non-call center calls.

• �Enable calls to agents in wrap-up state - If inactive, agents in Wrap-Up state are unavailable and 
will not receive queue calls. 

• �Enable maximum ACD wrap-up timer – If this option is active, agents in wrap-up state will have a 
maximum wrap-up time before they are forced to Available state.  

• �Automatically set agent state after call – When selected, this will force the agent’s status to change 
after the call to the option selected in the drop down. 

• �Automatically answer calls after waiting - When selected, this will force the call to be answered by 
an agent after waiting a predetermined number of seconds set by the Call Center Administrator.  

Assigning Users

AGENTS

Assigning Users allows an administrator to select the agents for a call center queue.

To add one or more Assigned Users:

1. Select agents from the list of Available Users on the left of the window.  

2. Click Add or Remove to assign Users to a call center.

3. Click Save to save selection.
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Depending on the policy assigned to this call center queue, the system may route calls to agents  
in the order they are listed in the Assigned Users column.

• To move a user up in the list, click the name in the Assigned Users column and click Move Up.

• To move a user down in the order, click a name in the Assigned Users column and click Move Down.

Click Save to keep your changes.

SUPERVISORS

The Supervisor area of the Profile page allows an administrator to select the supervisors for  
a call center queue.

To add one or more Assigned Supervisors:

1. Select from the list of Available Supervisors on the left of the window.

2. Click Add or Remove to assign a supervisor to a queue.

NOTE: Only users that have purchased the optional Call Center Supervisor option will display in the  
Available Users window.

3. Click Save to save selection.
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Call Center Features

ASSIGNED SERVICES

This area will display the complete list of the services purchased for the current queue.

Directory Number Hunting 

This feature enables you to route all User/Agents Direct Inward Dial (DID) calls to the Call Center queue.   

When a User/Agent is assigned this feature, the User will no longer receive DID calls to their own station. In 
other words, all calls directed to their number will route to the call center queue and receive the same 
treatment as calls routed to the queues designated number. Please note that this option will override the 
Users routing and call handling options, including Voice Messaging, Call Forward (all types), and other 
advanced features (Simultaneous Ring, Remote Office, Sequential Ring, etc.).  

To assign Directory Number Hunting to a User/Agent:

1. �Select the User in 
the Available Users 
column.

2. �Click Add to assign 
the user this feature.

3. Click Save.

QUEUE STATUS & ALERTS

This feature is not supported at this time.

CODING INBOUND CALLS

Call Disposition Codes are not currently supported.   
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Announcements & Music On Hold

When a call is received by your call center queue, various audio announcements can be played to 
the caller. Default audio files are provided for each announcement/treatment. You can create custom 
announcements that can be loaded or retrieved by selecting:

• Load custom files – These are .wav files that are loaded directly via the Call Center web page.

• Uniform resource locator (URL) is not supported at this time.

You also have the ability to load up to four custom audio files for each announcement. This enables 
the use of announcement fragments that can be shared across multiple services. To record greetings, 
please see the Uploading a Greeting or Music on Hold section. Once recordings are complete, you 
can set up your announcements.

To begin setting up your announcements and music on hold, click on Profile > Announcement 
Messages.

ANNOUNCEMENTS

The Announcements page allows you to select multiple announcement types: Entrance Message, 
Estimated Wait Time, Comfort Message, Music On Hold, and Call Whisper. To select which message you 
will edit, please select the drop-down menu.

NOTE: Changes to the main Call Center Announcements and Music On Hold will be applied to any 
associated Dialed Number Identification Service (DNIS) numbers. Please see the DNIS section for 
more information.

Entrance Message

You can select an entrance message for inbound calls to hear before they are placed in queue.  
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• Play entrance message – Check or uncheck to select to use an entrance message.

• �Entrance message is mandatory when played – By selecting this, customers will not be able to exit 
the queue without listening to the entire entrance message. 

• The Audio section allows you to select a specific entrance message. Choose from the following options:

- �Default - Callers hear the following default message: “Your call is very important to us, please wait for 
the next available agent or press zero to leave a message.”

- �Custom – Callers hear a custom message you have recorded and have saved as a .wav file. To 
load a custom file:

1. Click in Load Custom Audio Announcement field and browse to select your custom .wav file. 

2. After selecting the file, click Upload to upload the file.

3. Click Save.  

- URL – This is not a supported feature at this time.

Estimated Wait

The Estimated Wait Message (EWM) provides queue information to the caller. When a new call is added 
to the call queue, the EWM is played after the entrance message but before any other announcement. 
If the entrance message is disabled and the EWM is enabled, the EWM is played.

The estimated wait message announcements are localized according to the statistics of the queue. If 
the caller overflows to another queue, they hear a new EWM if the message is enabled.

• �Enable estimated wait message for queued calls – Check or uncheck to enable estimated wait 
messaging.This announcement has two modes of operation:

- �Announce queue position: In this case, the caller is informed of their current position in the call 
queue (for example, “You are caller number 12 in the queue”). To enable:
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1. Select the radio button for Queue Position. 

2. �Next, set a threshold for what queue position or lower a caller should hear the EWM.  
You can also check or uncheck the option to play a high volume EWM.

3. Click Save.

• �Announce wait time: In this case, the caller is given an estimated number of minutes they will wait 
for their call to be answered by an agent (for example, “Your estimated wait time is 5 minutes”). To 
enable:

1. Select the radio button for Wait Time. 

2. �Set a threshold for what wait time or lower a caller should hear the EWM. You can also check or 
uncheck the option to play a high volume EWM. 

3. Set the default handling time, as this will calculate the wait time for the caller.	

4. Click Save.

Comfort Message

These messages are played to the caller after the Entrance Message. The Comfort and Music on Hold 
messages keep playing to the caller in a loop until the call is answered by an agent or until action is 
taken by a Routing Policy (for example, Overflow).

• �Play comfort message – Check or uncheck to enable comfort messaging.

• �Time between messages – This defines the frequency and interval that the Comfort Message is 
played
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• �The Audio section of the screen allows you to select a Comfort message from the following options:

- �Default - Callers hear the following default message: “Your call is very important to us, please wait for 
the next available agent or press zero to leave a message.”

- Custom – Callers hear a custom message you have recorded and have saved as a .wav file. 

1. Click in the Custom field and browse to select your custom .wav file. 

2. After selecting the file, click Upload to upload the file. 

3. Click Save.  

- URL – This is not a supported feature.

Music On Hold

These messages are played to the caller after the entrance 
message. The Comfort and Music on Hold messages keep 
playing to the caller in a loop until the call is answered by an 
agent or until action is taken by a Routing Policy (for example, 
Overflow).

Enable music on hold for queued calls – Check or uncheck to 
enable Music on Hold.

• �The Audio section of the screen allows you to select the Music 
on Hold message from the following options:

- Default – Callers hear the default Music on Hold audio 
message.

- �Custom – Callers hear a custom message you have recorded and have saved as a .wav file. To set 
a custom message:

1. Click in the Custom field.

2. Browse to select your custom .wav file. After selecting the file, click Upload to upload the file.

3. Click Save.

- External Source – This is not supported at this time.

- URL – This is not supported at this time.
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Call Whisper

The Call Whisper message is played to the agent immediately before the inbound call is connected.

The message typically announces which call center queue the call is coming from. This is especially 
important when using Direct Number Identification Service (DNIS). For example, ten separate numbers 
can all be routing to a single queue. Each of the ten numbers can have their own customized Call 
Whisper message. This allows the agent to know which number was dialed and provide the appropriate 
greeting (without the need to look at their phone or directory).

• Play whisper message – Check or uncheck to enable Call Whisper.

• The Audio section of the window lets you select a Whisper message from the following options:

- Default - Agents hear the default Call Whisper audio message.

- �Custom – Agents hear a custom message you have recorded and have saved as a .wav file.  
To use a custom message:

1. Click in the Custom field and browse to select your custom .wav file. 

2. After selecting the file, click Upload to upload the file.

3. Click Save.  

- URL – This is not a supported feature.
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Inbound Call Handling

Distinctive Ringing

This policy provides a distinctive ring to a call when it is routed from a queue. Distinctive ringing patterns 
can be used with Call Center so agents can distinguish between an ACD-related call, a direct dialed 
call, and calls from different queues.

To access this feature, click on Profile > Distinctive Ringing.

• �Enable distinctive ringing for call center calls – Check or uncheck to enable distinctive ringing for 
the current call center.

• �Ring Pattern – There are four different patterns to choose from: Normal, Long-Long, Short-Short-Long, 
and Short-Long-Short.

• �Ring Pattern for forced delivered call center calls – Select one of the four patterns to associate 
with the calls that are force forwarded.

Click Save to apply any changes.

Direct Number Identification Service (DNIS)

Call centers have the capability to be associated with multiple DNIS numbers. DNIS allows a single 
combined queue to distribute calls to agents and also prioritize these calls so that more important calls 
are distributed first. DNIS lets calls be tagged so that an agent knows what number the caller dialed. 
This allows a single queue to support multiple call centers without the caller knowing that they have 
been combined into a larger group. In addition to the primary number, 63 different phone numbers are 
assignable to a call center. 

Priority is attached to an incoming call based on the DNIS number on which it is received and the wait 
time if the call is transferred from another call center. The calls are distributed to the agents staffing the 
queue based on this priority, with calls of the highest priority being exhausted before calls in the next 
priority group. TDS provides the ability to promote calls from a lower priority to a higher priority if the calls 
have been waiting long enough. The supervisor can also promote calls using the Supervisor client. This 
prevents the lower priority calls from being stranded in the queue during periods of high traffic.
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All the treatments available to a queue can be customized based on the DNIS number. This provides  
more differentiation for the caller and also provides the agent with additional information about when 
the call was received.

Use multiple DNIS numbers with a call center when the Agents and Routing policy apply to all the DNIS 
numbers. For example, when a single pool of agents handles calls for multiple inbound numbers, the 
calling party receives custom greetings associated with each DNIS number. The agent sees the DNIS 
number when the call is offered, allowing them to provide the appropriate greeting.

You can find your DNIS settings by selecting Profile > Call Center DNIS.

• Display DNIS Number - Check or uncheck to display the DNIS number instead of the calling number.

• Display DNIS Name - Check or uncheck to the DNIS name rather than the calling name.

• �DNIS Priority Settings – These fields are used to determine the thresholds for promoting calls from one 
DNIS priority to another. The settings prevent call “starvation”, where a call could remain queued for a 
long time if there are always calls coming into the queue with higher priority. To use this feature:

1. Select the check boxes to enable and enter time in seconds. 

2. Click Save to complete any changes.

EDITING DNIS 

This area allows you to edit options for individual DNIS numbers. Begin by selecting the DNIS number you 
would like to edit by opening the drop-down menu beneath Edit DNIS.
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• �Priority - Select the priority level for the DNIS from the following options: Highest, High, Medium, and 
Low.

• �Calling Line ID – Select this option to provide a display phone number. This number is used instead of 
the DNIS phone number for display purposes.

• �Calling Line Last/First Name - Select this option if a custom calling name should be used for display 
purposes.

- �Allow outgoing call center call - Select this option if agents staffing this call center are allowed to 
initiate outbound call campaigns for this DNIS.

Click Save to apply any changes.

Announcements - For information on configuring Announcements for DNIS, see the Announcements & 
Music on Hold section.
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Calling Features 

You can access your Call Center’s Calling Features by selecting Call Features > All Services.  

For more information on these services, please see the managedIP Administrator User Guide.

Routing your calls

Main Routing Policies

You can see routing options at the Enterprise level by selecting Call Center > Routing Policies.
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• �Longest Wait Time - When this setting is selected, the longest waiting call is selected and delivered to 
the agent.

• �Priority Order - If this setting is selected, then a list of queue precedence is configured from all the 
queues of the group/enterprise. The call from the highest precedence queue that the agent is staffing 

is selected and delivered to the agent. 

For examples of how these features are used, please see the Use Cases section.  

Alternate Routing Policies

You can see alternative routing options at the Group level by selecting Profile > Routing Policies.

FORCED FORWARDING

The Forced Forwarding policy is useful 
when there is an emergency or no 
agents are available to staff a call 
center. The administrator or supervisor 
can temporarily redirect all new calls 
to an alternate call center until the 
situation is resolved.

If the option is enabled, then 
incoming calls to the queue are 
forwarded to the configured destination. Calls already in the queue remain queued. The call center 
can be configured to play an announcement prior to forwarding the queued calls. In this case, the 

announcement is played once before forwarding is complete.

• Forced Forwarding - Check or uncheck to enable forced forwarding for the current call center.

• Call Forward to phone number - Define where you would like calls forwarded.

• �Allow feature access code to configure - Specify whether feature access codes activate and 
deactivate the forced forwarding of calls.

• �Play announcement before forwarding - Check or uncheck to enable an announcement when a 
call is forced forwarded for the current call center.

- �To configure the announcement for Forced Forwarding, see the Announcements & Music-On-Hold 
section
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HOLIDAY SERVICE

You can set parameters for how calls are processed during holiday periods in the Holiday  

Service area of your screen.

• �Action – Specify the action to apply to calls during the holiday schedule. The options are: None, 
Perform busy treatment, and Transfer to phone number/SIP-URI. If using transfer, please enter the 
applicable destination number.

• �Holiday Schedule - Specify schedule to be followed for the Holiday Service policy by selecting from 
the drop-down menu. 

NOTE: The schedules listed here are determined on the Enterprise level. For more information on 
configuring schedules, see the managedIP Administrator User Guide.

• �Play Announcement before holiday service action - Check or uncheck to enable an 
announcement when a call goes in to holiday service for the current call center.

- �To configure the announcement for Holiday Service, see the Announcements & Music On Hold 

section

NIGHT SERVICE

Calls can be processed differently during non-business hours. Business hours are defined as a time 
schedule at the Group level. The Routing Policy refers to this and applies a specified routing action when 
a call is received outside of business hours. By default, an “Every Day, All Day” business hour schedule is 
defined for the queue. For more information on configuring time schedules, please see the managedIP 
Administrator User Guide.

Manual Night Service can be used for times when the call center closes earlier than usual due to a 
holiday, special event, or an operational problem.
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• �Action – Specify the action to apply to calls during the night schedule. The options are: None, Perform 
busy treatment, and Transfer to phone number/SIP-URI. If using transfer, please enter the applicable 
destination number.

• �Force night service - Specify schedule to be followed for the night service policy using the drop-down 
menu.

• �Play Announcement before night service action - Check or uncheck to enable an announcement 
when a call goes in to night service for the current call center.

- �To configure the announcement for Forced Forwarding, see the Announcements & Music On Hold 

section

�NOTE: There are two announcement options available with Night Service when it is manually 
overriden: Normal announcement and Manual mode announcement.  You will need to configure 
both if allowing manual overrides of Night Service.
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BOUNCED CALLS

The Bounced Calls section of the screen allows you to configure specific routing behavior if a call 
offered to an available agent is not answered. A bounced call is a call that is being routed to the agent 
but for some reason (agent does not answer the call, they change to unavailable, their device is not 

registered, and so on) the call is not answered. 

• �Bounce calls after “X” rings – Check or uncheck to enable Bounced Calls for the current call center 
queue and specify the number of rings before a call is bounced.

• �Transfer to phone number/SIP-URI - Check or uncheck to enable Transfer and then enter the 
applicable destination number.

• �Bounce calls if agent becomes unavailable while routing the call - Check or uncheck to bounce 

calls to an agent who becomes unavailable.

COMFORT MESSAGE BYPASS

At times of low call volume, the Comfort Message Bypass can be enabled for calls that will be answered 
quickly instead of the usual Comfort/Music on Hold treatments. This policy applies after the Entrance 
Message has finished playing (if applicable).
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• �Enable Comfort Message Bypass  – Check or uncheck to enable bypassing the comfort message 
for the current call center.

• Estimated Wait Time - Specify the estimated waiting time before the comfort message is skipped.

• �Play announcement after ringing - Specify whether the comfort message bypass announcement 
plays after ringing and then the interval after which it plays.

• �Play Announcement before forwarding - Check or uncheck to enable an announcement when a 
call is forced forwarded for the current call center.

- �To configure the announcement for Forced Forwarding, see the Announcements & Music on Hold 

section

OVERFLOW

These overflow scenarios occur when a 
queued call is not handled (either by an 
agent or by another Routing Policy) within 
a specified amount of time. The call is 
removed from the queue and handled 
according to the related Overflow policy 

actions.

• �Action – Specify the action to apply to 
overflow calls. The options are None, 
Perform Busy treatment, and Transfer to 
phone number/SIP-URI. If using transfer, 
please enter the applicable destination 
number.

• �Enable Overflow after wait X seconds  - Check or uncheck to enable overflow for the current call 
center queue and specify the waiting time after which a call is considered an overflow.

• �Play Announcement before performing holiday service action - Check or uncheck to enable an 
announcement when a call goes in to overflow for the current queue.

- �To configure the announcement for Forced Forwarding, see the Announcements & Music on Hold 
section
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STRANDED CALLS

A stranded call is one that is being assigned to a queue where no agents are currently staffed.  

NOTE: An agent is said to be staffing a queue if the agent has joined the queue and is not in the  
Sign-out state.

If the last agent staffing a queue “un-joins” the queue or signs out, then all calls in the queue become 
stranded and handled as specified. In particular, if the mandatory Entrance Message option is enabled, 

then the entrance message is played to completion before the call is handled as a stranded call.

• �Action – Specify the action to apply to stranded calls during the holiday schedule. The options are 
None, Perform Busy treatment, Transfer to phone number/SIP-URI, Night Service, Play Ringing until caller 
hangs up, or Play announcement until caller hangs up.  

- If using transfer, please enter the applicable destination number.  

- If selecting Night Service, please see the Night Service section of this guide.

- If using an announcement, see the Announcements & Music On Hold section.

Uploading a Greeting or Music On Hold

Below is the procedure to record a personal greeting or announcement using a PC. Instructions are 
provided for the following sound recorders:

• Windows 98 Sound Recorder and Windows XP Sound Recorder
• Windows 2000 Sound Recorder
• Windows NT Sound Recorder
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If you are using a different sound recording product, the required format for recordings are:

• CCITT u-Law or A-Law
• 8,000 kHz
• 8-bit mono
• .wav file 

To record using the Windows 98 Sound Recorder or Windows XP Sound Recorder:

1. �In Windows 98, select Start> Programs> Accessories> Multimedia> Sound Recorder from the 
Windows task bar. In Windows XP, select Start> All Programs> Accessories> Entertainment> Sound 
Recorder

NOTE: It is possible that your Sound Recorder is in a different location, or that your default sound 
recorder is another product. Please note the required format for your greetings below and follow the 
instructions for your specific sound recording product.

2. �Make the setting selections. Click Properties from the File menu. The properties for Sound window 
appears.

3. Click Convert Now and then click OK. The Sound Selection page appears.

4. Select CCITT u-Law from the Format list.

5. �Select 8,000 kHz, 8-bit mono under Attributes and click OK. You may want to save this format at this 
point, so that you can easily select it in the future. 

6. In the Properties for Sound dialog box, click OK.

7. �Click Record on the Sound Recorder. Speaking clearly into your PC microphone, record your 
message. When you have finished, click Stop. To listen to your message, click Play. If you are not 
pleased with your message, record it again.

8. �When you are satisfied with your message, select Save As from the File menu. Name your sound file, 
being certain that you remember its location and that the file type is a .wav file.

9. In the File name field, enter the desired name of your recording.

10. Click OK. To exit without saving, click Cancel.
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To record using the Windows 2000 Sound Recorder:

1. �Select Start> Programs> Accessories> Multimedia> Sound Recorder from the Windows task bar.

NOTE: It is possible that your Sound Recorder is in a different location, or that your default sound 
recorder is another product. Please note the required format for your greetings below and follow the 
instructions for your specific sound recording product.

2. �Click Record on the Sound Recorder. Speaking clearly into your PC microphone, record your 
message. When you have finished, click Stop. To listen to your message, click Play. If you are not 
pleased with your message, record it again.

3. �Click OK.

4. �Click Change to modify the settings. Select CCITT u-Law from the Format list. Select 8,000 kHz, 8-bit 
mono under Attributes and click OK. You may want to save this format at this point, so that you can 
easily select it in the future. In the Properties for Sound dialog box, click OK.

5. �When you are satisfied with your message, select Save As from the File menu. Name your sound file 
as .wav file.

6. In the File name field, enter the desired name of your recording.

7. Click OK. To exit without saving, click Cancel.

To record using the Windows NT Sound Recorder:

1. Select Start> Programs> Accessories> Multimedia> Sound Recorder from the Windows task bar.

2. �Select Audio Properties from the Edit menu. Click on the Customize button under Preferred quality. 
The Customize dialog box appears.

3. In the dropdown menu under Format, select CCITT u-Law.

4. �In dropdown menu under Attributes, select 8.000 kHz, 8-bit mono. You may want to save this format 
at this point, so that you can easily select it in the future.

5. Click OK in the Customize dialog. Then click OK in the Audio Properties dialog box.

6. �Click Record on the Sound Recorder. Speaking clearly into your PC microphone, record your 
message. When you have finished, click Stop. To listen to your message, click Play. If you are not 
pleased with your message, record it again.

7. Click OK.

8. �When you are satisfied with your message, select Save As from the File menu. Name your sound file 
as a .wav file.

9. In the File name field, enter the desired name of your recording.

10. Click OK. To exit without saving, click Cancel. 



31

managedIP Hosted
Call Center Administrator Guide

17
94

77
/4

-1
8/

10
54

1

User Tags

The User Tags feature allows the managedIP Administrator to make changes and modifications to phone 
features and functions on a per-user, per-phone basis. This enables the Administrator to provide specific 

customizations for individual users to help improve the usability of the phones.

TO CHANGE A TAG VALUE:

1. Select the Group.

2. Select a telephone number from the User dropdown filter.

3. �In the Device section of the Profile page, click Modify Tags. A pop-up window containing the list of 
available tags with the current tag value will appear.

4. Locate the tag to be changed and update the new value of the tag. Tag descriptions are shown 
below.

5. Click Save.

6. Click Rebuild Device Config File.

7. Verify that the message “Device config file successfully rebuilt” is displayed.

NOTE: For the changes to take effect, the phone must be reset. Rebooting the phone will 
disconnect any call that may be in progress. Also, different phone models may have different tags 
available to them. The table at the end of this document contains a complete list of tags and the 

availability of tags by phone.

Agent Web Portal Settings

JOINING A CALL CENTER AND CHANGING CALL CENTER STATE 

As an Agent, you have the ability to join a Call Center queue in order to receive calls. 

To join a call center and change your status:

1. At the User level, select Calling Features – Call Control.

2. �Click the View Call Centers button to the right of Call Center – Agent. The button will then change 
to Hide Call Centers.
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3. �Click each box under the header titled Join to join the Call Center(s) you wish to join and then select 
the ACD state and unavailable code from the dropdowns.

4. Click Save.

NOTE: Basic Agents are not able to change their State (available, unavailable, etc.), but can join 
any queues they are assigned to (if permitted by the administrator). 

CHANGING AGENT SETTINGS

To change Guard Timer or Unavailable Settings:

1. Click the Edit button to the right of Call Center – Agent. The following screen will then pop up: 
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2. Check or uncheck the boxes to change the Guard Timer Settings.

3. Click Save.

For more information on configuring Guard Timer and Unavailable Settings, please see the Agent 

Default Settings section.

FEATURE ACCESS CODES

There are a number of Feature Access Codes that can be entered in to your phone that directly apply 
to Call Center functionality. They are as follows: 

Escalate Call to Supervisor (#83)

Forced Forwarding Activation/Deactivation (#72/#73)

Initiate Silent Monitoring (#82)

Make Outgoing Call as Call Center (#80)

Make Personal Outgoing Call (#81)

Monitoring Next Call (#84)

Night Service Activation/Deactivation of Manual Override (#70/#71)

Supervisor Web Portal Settings
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JOINING A CALL CENTER AND CHANGING CALL CENTER STATE 

As a supervisor, in addition to having the ability to monitor agent and queue status, you can also join a 

queue to take calls. 

To join a call center and change your status:

1. �At the User level, select Calling Features – Call Control

2.� �Click the View Call Centers button to the right of Call Center – Agent. The button will then change 
to Hide Call Centers. 

3. �Click each box under the header titled Join to join the Call Center(s) and then select the ACD state 
and unavailable code from the drop-down.

4. Click Save.

ADD/REMOVE SUPERVISED AGENTS 

To add or remove supervised agents:

1. �At the User level, select Calling Features – Call Control.

2. �Click the View Call Centers button to the right of Call Center – Supervisor. The button will then 
change to Hide Call Centers.

3. �Click on the Edit button to the right of the 
Call Center queue you wish to edit. 

4. �Click on the agent(s) you, as the supervisor, 
either want to add or remove.

5. Click Save.
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NOTE: Any changes made to your Call Center “state” via the web portal will be reflected (real-time) 
on both your Polycom telephone and your desktop client (if used). 

CHANGING AGENT SETTINGS

To change Guard Timer or Unavailable Settings:

1. Click the Edit button to the right of Call Center – Agent. The following screen will then pop up: 

2. Check or uncheck the Agent Settings to make them active.

3. Click Save.

For more information on configuring Guard Timer and Unavailable Settings, please see the Agent 
Default Settings section.

FEATURE ACCESS CODES

There are a number of Feature Access Codes that can be entered in to your phone that directly apply 
to Call Center functionality. They are as follows: 

Escalate Call to Supervisor (#83)

Forced Forwarding Activation/Deactivation (#72/#73)

Initiate Silent Monitoring (#82)

Make Outgoing Call as Call Center (#80)

Make Personal Outgoing Call (#81)

Monitoring Next Call (#84)

Night Service Activation/Deactivation of Manual Override (#70/#71)
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Use Cases

Longest Wait Time & Priority Order

USE CASE 1 – PRIORITY ROUTING – PRECEDENCE

Two agents are staffing two queues of a group/enterprise:

• Technical support
• Customer service

The customer service is configured with the highest precedence and both queues have a single call 
waiting to be handled by an agent. The call in the technical support queue has been waiting the 

longest.

The first agent frees up and becomes available to take a new call. Because the customer service 
queue has the highest precedence, the call from that queue is delivered to the agent.

The second agent frees up and becomes available to take a new call. The customer service queue is 

empty, so the call from the technical support queue is delivered to the agent.

USE CASE 2 – PRIORITY ROUTING – LONGEST WAITING TIME

Two agents are staffing two queues of a group/enterprise:

• Technical support
• Customer service

Both queues have a single call waiting to be handled by an agent and the call in the technical support 
queue has been waiting the longest.

The first agent frees up and becomes available to take a new call. Because the call from the technical 
support queue has been waiting the longest, the call from that queue is delivered to the agent. 

The second agent frees up and becomes available to take a new call. The technical support queue is 
empty and the call from the customer service queue is delivered to the agent.
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USE CASE 3 – PRIORITY ROUTING – BOUNCED CALLS

Two agents are staffing two queues of a group/enterprise:

• Technical support
• Customer service

Both queues have a single call waiting to be handled by an agent and the call in the technical support 
queue has been waiting the longest. However, the call in the customer service queue was offered once 
to an agent and then bounced back to the queue.

The first agent frees up and becomes available to take a new call. Because the call from the customer 
service queue was offered to an agent and bounced already, the call from that queue is delivered to 
the agent.

NOTE: Tags shown in the web portal are based on the phone model being modified. With the IP650, 
all tags associated to a line key will appear with 34 options. Lines 7-34 are only applicable if the 
phone is equipped with an expansion module.
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Item Tag Description Default Options
Supported
Devices 

1

DIRECTORY_
CONTACT_
NAME_ON_
CALLERID

This allows for calls made to or 
received from contacts in your 
directory to appear as entered. 
For example, if Jon from ABC 
Company is entered as a contact 
in your phone directory, the Caller 
ID will Display exactly as it was 
entered in the directory versus 
how it is set-up with the phone 
company for Caller ID.

0 (off)
0 = Off

1 = On

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X

2
CALL_
FORWARD_
SOFT_KEY

If enabled, the “Forward” soft 
key will be displayed and allows 
the user to update Call Forward 
Always, Call Forward No Answer, 
and Call Forward Busy, directly 
from the phone. Updates made 
via the phone will also be updated 
in the toolbar and web portal 

0 (off)
0 = Off

1 = On

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450

3

TEXT_LABEL_
FOR_
LINEKEY_<x>   

(x= 1-34)

This allows for display labels to 
be customized for shared call 
appearances or secondary 
numbers to display a name versus 
a number. For example, if 608-
555-1213 is the number displayed 
on a phone, this feature will allow a 
name to be displayed instead.

Note: This feature is applicable 
to each individual line key that 
appears on a phone up to a 
maximum of 34 lines with phones 
that have an expansion module

<null>

<null> =  
Line Port  
appears (e.g., 
6085551212 
or if SCA, 
6085551212_
SCA_1) <text> 
= <text value> 
(e.g., “555-
1212”, “Jane 
Doe”, “TDS 
Telecom”) 

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550

4
DATE_TIME_
IN_24_HOUR_
FORMAT

Display time in 24-hour “military 
time” or choose standard AM / PM 
format.

0 (12 
hr)

0 = 12 hour 
clock i.e. AM/PM

1 = 24 hour 
clock i.e. 15:30  

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X
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Item Tag Description Default Options
Supported
Devices 

5
CALL_WAITING_
TONE

Specifies the tone heard on an 
incoming call when another call 
is active (i.e., call waiting).

beep

beep = brief    
“beep” 

ring = normal 
ring tone 

silent = no 
tone or ringing 

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X

6
HANDSFREE_
SPEAKERPHONE_
ENABLED

Allows the speakerphone function 
to be disabled. 

When the phone is disabled: 

• �The phone will display the 
message “Hands free mode 
disabled” when a user 
depresses the speakerphone 
key

• �Click-to-dial calls will revert to 
the handset or headset 

1 
(enabled)

0 = Disable 

1 = Enable 

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X

7

HOLD_RECALL_
ENABLED

“Hold Recall” provides periodic 
notification to the user that 
call(s) have been on hold for an 
extended period of time. 

0 (off)
0 = Off

1 = On

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X

HOLD_RECALL_
INITIAL_TIMER

Time (in seconds) to wait before 
an initial reminder is provided for 
a call on hold.

90 (secs) <seconds>

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X

HOLD_RECALL_
SUBSEQUENT_
TIMER

Time (in seconds) to wait after 
the initial timer that subsequent 
reminders are provided for a call 
on hold.

60 (secs) <seconds>

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X
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Item Tag Description Default Options
Supported
Devices 

8

CALL_
CENTER_
SOFT_KEYS

For Call Center agents, this 
option adds soft keys to phone 
enabling agent to Sign In/Out, 
and change state (Available / 
Unavailable).  

0 (no soft 
keys)

0 = No  
soft keys

1 = CC  
soft keys

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X

CALL_
CENTER_
AGENT_LINE_
KEY

The key used to support the Call  
Center agent sign-in function 
(special icons used), interworks 
with Call Center soft keys.

1 (key)
1 – 34  
<line key>

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X

CALL_
CENTER_
AGENT_SIGN_
IN_

STATE 

The state of the Call Center 
User when signing in to the Call 
Center queue.  

1 
(available)

0 = Unavailable

1 = Available

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X 

9

MWI_
ENABLED_
FOR_LINE_KEY_

<x> (x= 1-34)

The Message Waiting Indicators, 
both the red LED light at the top 
of the phone and the envelope 
icon next to the line key may be 
disabled on a per line key basis. 

Note: If enabled on a single 
line key, the MESSAGES key will 
go directly to Voice Messaging. 
If enabled for 2+ line keys, the 
MESSAGES key will present a 
“Line Select” menu, prompting 
the user to select the line 
key they desire to retrieve 
messages.  

Registration

(enabled)
Registration = 
On <null> or 
disabled = Off

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X 
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Item Tag Description Default Options
Supported
Devices 

10

MISSED_
CALLS_LIST_
AND_

COUNTER_
ENABLED

When enabled, missed calls will 
increment the “Missed Calls” 
counter on the display and the 
missed calls will be logged in the 
“Missed Calls List”.  

1 (Line 
Key 1)

0 (Line 
Keys  
2 -34)

0 = Off  
(does not log)

1 = On 

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X 

HOLD_
RECALL_
INITIAL_TIMER

Time (in seconds) to wait before 
an initial reminder is provided for a 
call on hold.

90 (secs) <seconds>

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X 

HOLD_
RECALL_
SUBSEQUENT_
TIMER

Time (in seconds) to wait after 
the initial timer that subsequent 
reminders are provided for a call 
on hold.

60 (secs) <seconds>

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 
560/550, 
450, 33X 

11

HOTLINE_
ENABLED_
FOR_LINE_
KEY_<x>

When enabled, a call will be 
automatically placed to the “Hotline 
Number”, which can be set by 
completing Tag X.

0 
(disabled)

0 = Disabled

1 = Enabled

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 560/550, 
450, 33X 

HOTLINE_
NUMBER_ 
DIALED_FOR_
LINE_

KEY_<x>

You first must enable this feature 
to set a predefined number to be 
automatically dialed. See Tag X to 
enable this function.

<null>

<DN> (any 
valid internal 
or external 
telephone 
number that 
can be dialed 
directly from the 
station)

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 560/550, 
450, 33X 

12
CALLER_ID_
NUMBER_ 
BEFORE_NAME

When activated, the phone will 
display the Caller ID number before 
the Caller ID Name. 

0 (name 
first)

0 = Off  
(name first)

1 = On  
(number first)

VVX Series 
600, 50X, 
41X, 310

SoundPoint 
650, 560/550, 
450, 33X 
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Additional Support

• Contact Technical Support at 1-888-850-5915 or

• Visit support.tdsmanagedip.com/hosted for additional resources


